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editing One Legal’s publications. Before One Legal he spent 
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Please note that many of the examples in this ebook use the most recent version of 
Adobe Acrobat (Adobe Acrobat DC — available here). We do because it’s the most 
widely used PDF editing tool and the one favored by most courts. Other tools are are 
available. Please consult our buyer’s guide to PDF editing software for more 
information.  
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Formatted correctly 

Is your document formatted according to court rules? 

Electronically filed documents must adhere to the same strict formatting requirements of printed 

documents.  

 

Some state rules of court, for example in California, specify the font size, style and color that 

can be used in court filings. There are also rules (contained, in California, in Chapter 1 of the 

Trial Court Rules) that specify the size of margins, the size of spaces between lines, and how 

pages should be numbered.  

Format for on-screen readers 

When you file electronically, the chances are that your document will always be read on-screen 

rather than being printed.  

 

We typically find that in eFiling courts, more than half of judges choose to read papers on-

screen, either on a laptop or a tablet. The ABA has found that in the federal courts, where 

electronic filing is well established, the majority of judges now read on-screen. 

So, while it is likely that a minority will continue to favor paper — meaning that you’ll definitely 

want to look for an eFiling service provider, such as One Legal, that includes courtesy copy 

delivery — many will now be reading your filings electronically. 

“So what?” you might be thinking. The problem is that people read differently on-screen than 

they do on paper. For example, a 2014 study comparing comprehension and recall after reading 

either on paper or on a Kindle found that on-screen readers performed “significantly worse” 

when it came to recall of the main facts and order of arguments. 

That’s because on-screen readers read differently. Martin Siegel, a lawyer in Texas where 

eFiling has been around for a decade, has noted that “online readers jump around, skimming 

and seizing on bits of text… they seek content in an F-shaped pattern, looking down the left side 

for structural clues and then focusing on headings and first sentences of paragraphs.” 

Best practices 

Choose your font carefully 

There are still a handful of courts out there that haven’t yet received the memo about the 

demise of the typewriter and still insist all filings be in courier font (the one that looks like 

http://www.courts.ca.gov/cms/rules/index.cfm?title=two
http://www.courts.ca.gov/cms/rules/index.cfm?title=two
http://www.americanbar.org/content/dam/aba/events/judicial/14midyear_calprogram_clematerials.authcheckdam.pdf
http://www.theguardian.com/books/2014/aug/19/readers-absorb-less-kindles-paper-study-plot-ereader-digitisation
http://www.legaltechnews.com/id=1202475787839


typewriter letters). California, for example, doesn’t require it, but does still list it in their rules as 

one of the font-types an attorney’s final choice must be “essentially equivalent” to (CRC, 2.105). 

Courier, and other similar monospaced fonts (so named because every character is the same 

width), served a single purpose — to suit the mechanical requirements of typewriters. They 

weren’t designed to be easy to read or attractive on the page.   

So, what should you use instead? Some would argue that the most readable fonts are sans serif 

(straight, with no flicks). That’s certainly true for signs, headings, and other pieces of information 

that will be glanced at. It’s why Helvetica has been used the world over for signage in public 

transit systems, for example. 

There’s some evidence, though, to suggest that readers are better able to recall information 

from longer pieces of writing when they’re typed in a serif font (curvy, with tail flicks). Times New 

Roman is an acceptable choice, but other system fonts (fonts found by default in programs like 

Microsoft Word), such as Cambria and Georgia are better (both, by the way, meeting 

California’s requirements). 

Give your words some space on the page 

Often there’s a temptation to squeeze as much information as possible onto the page. A big wall 

of text is, however, very hard to read and difficult to stay focused on for very long — not ideal. 

The answer to readability is to embrace white space on the page. Here are five quick ways to 

better utilize white space to improve readability (all well within California’s court rules!): 

● Break up text with headings and sub-headings — Introduce new sections with a

heading or sub-heading that summarizes what’s to come. Capitalizing each word in a

header is up to you, but note that it is often easier to read when written in sentence case.

● Left align (rather than justify text) — The Chicago manual of style says it better than I

could: “Use left alignment. Full justification is ugly and more difficult to read.”

● Use 1.5 line spacing — A healthy gap between lines vastly improves readability and

makes it much easier to scan for particular pieces of information. California’s rules state

that either 1.5 or double line spacing can be used. Double line spacing creates

unnecessarily large gaps, so choose 1.5.

http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_105
https://en.wikipedia.org/wiki/Sans-serif
https://en.wikipedia.org/wiki/Sans-serif
http://www.bbc.com/news/blogs-magazine-monitor-26383185
https://hbr.org/2012/03/hard-to-read-fonts-promote-better-recall
https://en.wikipedia.org/wiki/Serif
http://www.chicagomanualofstyle.org/qanda/data/faq/topics/ManuscriptPreparation/faq0041.html
http://www.chicagomanualofstyle.org/qanda/data/faq/topics/ManuscriptPreparation/faq0041.html
http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_108


● Set larger left and right margins — There are few professional publications that use

letter-sized paper and small one-inch margins. Why? Because this often results in more

words per page than is comfortable to read. California sets minimum margin sizes, which

you’re welcome to exceed. Try setting at least 1.5 inches left and right.

● Use 13 pt, rather than 12 pt font — Now that eFiling is so prevalent, and on-screen

reading is a real possibility, you need to format for on- and off-screen readers. In

California, the minimum is 12 pt, but a little larger will be easier to read, especially on a

smaller screen, like that of an iPad.

Be consistent 

If you’re going to go to the effort of overhauling your typography for maximum readability, then 

it’s vital you’re consistent. Abrupt changes mid-document or changes in fonts from one letter to 

the next will imply a lack of care, attention, and professionalism. 

Establishing a style guide for your firm, specifying preferred margin widths, line spacing, font 

styles, and so on will go some way to achieving this. One of the easiest ways to ensure 

consistency, though, is to make use of the “Styles” functionality in Microsoft Word. It’s crucial to 

learn what a style is and to set yours up according to your firm’s preferred approach. 

Styles also help to ensure consistency between staff because the same default style set can be 

deployed on every employee’s’ computer. 

Looking for a way to make filing more convenient, especially if you 

simply don’t have time to complete your electronic or physical 

filing tasks? 

Meet Email to File, our new concierge service. How does it work? 

Simply log into your One Legal account, click on the Email to File icon, 

provide some information about your documents, and we’ll take care of 

the rest. It’s really that simple! 

http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_107
http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_107
http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_107
http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_104
http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_104
http://office.microsoft.com/en-us/word-help/style-basics-in-word-HA010230882.aspx
http://www.onelegal.com/products/email-to-file
http://info.onelegal.com/e/66252/onesource20customer20oct202016/8xjnh3/226869936


 

Exhibits bookmarked 
If you’re eFiling documents at court, whether in California, Texas, or elsewhere, it’s best practice 

to add electronic bookmarks so that the document is as easy to navigate as possible on a 

computer screen. 

In fact, if you’re filing in a California court, as of January 1, 2017, it is required by state rule to 

add electronic bookmarks to the exhibits appended to your filings. 

But what are electronic bookmarks and how do you add them to a document? 

What is an electronic bookmark? 

Electronic bookmarks work in much the same way as the little plastic or paper bookmarking tabs 

you add to printed filings. They are simply shortcuts to specific sections of a document which, 

when clicked, will take the reader directly to that section. 

Once added to a document, bookmarks appear in a navigation panel (typically on the left-hand 

side of the screen). In most eFiling courts, it’s required that the appended exhibits be 

bookmarked in this way so that readers can quickly and easily move between each one, without 

the need to scroll through the entire document. 

How to add bookmarks using Microsoft Word 

If your document is relatively simple and prepared entirely in Word, then adding bookmarks at 

this drafting stage is quick and simple. Here’s what to do: 

STEP ONE 

Open your document in Word and navigate to the section or heading you wish to bookmark. 

Select the title you wish to bookmark and then click on the Insert tab in the ribbon, followed by 

selecting Bookmark. 

http://www.courts.ca.gov/3025.htm


STEP TWO 

The Bookmark dialog box will open. Type the name of your bookmark and then click Add. 

Repeat this process until all required sections have been bookmarked. 



 

STEP THREE 

Finally, save your document as a PDF. To do this, click on Save As in the File menu. Select 

PDF in the drop down menu. Before saving, open the Options… menu at the bottom of the 

Save As dialog box. 

 

Make sure that that the option to Create bookmarks using: is selected and that it is set to use 

Word bookmarks. Click OK and then Save. 



 

 

How to add bookmarks using Adobe Acrobat 

If you have access to the professional version of Adobe Acrobat (i.e. the paid for version), then 

adding bookmarks once you’ve created your PDF is very simple. If you’re combining multiple 

documents into a single PDF or adding in scanned exhibits, this may be simpler than adding 

bookmarks in Word. 

To create a bookmark in Acrobat, follow these steps: 

STEP ONE 

Open your PDF document in Adobe Acrobat. Now scroll to the first section that you wish to 

bookmark. Select the heading or title of the section by dragging your mouse over it and, once 

selected, press CTRL+B on your keyboard. The Bookmarks panel will open on the left. 



 

STEP TWO 

In the bookmarks panel, type the name of the exhibit and a short description. Now, simply 

repeat this process until you’ve bookmarked all of the exhibits in your filing. 

Alternatives to Acrobat 

While Acrobat is widely regarded as the market leader in PDF editing software (other paid-for 

tools are available, however: Check out our buyer’s guide), it is quite expensive at $14.99 per 

user per month. Therefore, if you’re filing infrequently or only making simple changes to PDFs, 

you may wish to consider an alternative. 

Some free online tools 

● Open Source software — There are a few Open Source (that’s to say, freely available) 

PDF editing tools available. One of the most popular, Libre Office Draw, has similar 

functionality to Acrobat. There’s a discussion of alternatives over on opensource.com. 

● Bookmarking only tools — There are a handful of tools, like JPDFBookmarks, 

available that allow bookmarks to be added to existing PDFs but have no other features. 

https://www.libreoffice.org/discover/draw/
https://opensource.com/alternatives/adobe-acrobat
https://sourceforge.net/projects/jpdfbookmarks/


 

One Legal’s Email to File service 

Compared to Acrobat, however, the free tools detailed above are cumbersome and 

complicated. So, if you’re filing fairly infrequently, you might prefer to outsource the assembly of 

your electronic court filing to a team of dedicated document assembly and filing specialists 

experienced in using Adobe Acrobat. 

That’s exactly what you get when you use One Legal’s Email to File service! With Email to File 

you simply attach your documents to an email, share a few important details with us, and we’ll 

assemble and submit your filing on your behalf. Our team will save you time by making sure that 

your document is converted to PDF, made text searchable, and that all exhibits are 

bookmarked. 

 

 

 

 

 

 

 

 
 

 

 

 

 
 

http://www.onelegal.com/products/email-to-file/


 

Text searchable 

How to make a PDF text searchable 

It’s long been best practice to ensure that the PDF documents you file electronically with the 

court are text searchable. 

That’s because one can navigate searchable documents by looking up specific words and 

phrases, add markup (like comments) to specific sections, and copy and paste individual blocks 

of text. The result is a much more convenient experience for those reading and handling the 

documents. 

While it has long been a good idea, in many eFiling jurisdictions (including Texas and — from 

Jan 1, 2017 — California) it's actually required by rule  

Here’s what you need to know to ensure that you’re compliant and your documents are text 

searchable. 

Understanding the different types of PDF 

PDFs can be categorized in three ways, depending on how the file was created. How it 

originated also defines whether the content of the PDF can be searched or copied and pasted 

or whether it is “locked” in an image of the page. 

● Text-based or “true” PDFs: Digitally created PDFs, sometimes called “true” PDFs, are 

made by directly saving a document being drafted in a word processor (like Microsoft 

Word) as a PDF or by using the “print to PDF” function. 

● Image-based PDFs: Image-only PDFs are created through scanning, taking 

photographs, or taking screenshots. These documents are “locked” in a snapshot type 

image and are not searchable, cannot be copied and pasted, and cannot be marked up. 

● OCR’d or “made-searchable” PDFs: Image-based PDFs can be made text searchable 

via the application of optical character recognition (OCR). During the OCR process, 

characters and the document structure are “read.” As a result, a text layer is added to 

the image layer. Such documents become similar to “true” PDFs — though, depending 

on the quality of the image, or the recognizability of the writing, may not be 100% 

accurate. 

Method 1: Publish directly from your word processing software 

(preferred) 



 

If you want to guarantee that your final text searchable document exactly matches your original 

draft, then you must publish it directly as a PDF. 

In the recent past, this was a complicated process that leads to some people resorting to 

printing and scanning to create PDFs. Today it is a quick and straightforward process. It’s never 

necessary to print out and scan documents you’ve written yourself in a word processor to make 

them into a PDF. 

To save a Microsoft Word document as a PDF, follow these steps: 

STEP ONE 

Open your document in Microsoft Word. Next, click on File and then Save As. 

 

STEP TWO 

The Save As dialog box will open. Next, click on the File Format drop down menu and choose 

PDF. To save your document as a PDF, click Save. 



 

 

Method 2: Apply optical character recognition in your PDF software 

Note: This section describes how to apply OCR in the most recent version of Adobe Acrobat. 

Other PDF editing software is available. Check out our buyer’s guide for more information. 

Sometimes it just isn’t possible to save directly to PDF. For example, you mat have letters or 

other written exhibits that only exist in paper form or as photographs or items that are hand-

written. To make these items text-searchable requires that you apply optical character 

recognition. 

STEP ONE 

If your exhibits are not already in electronic form, you’ll need to create an image by either 

scanning or taking a photograph of the item. This will create an image file, possibly a PDF but 

just as likely an image file like a TIF, PNG, or JPG. 

STEP TWO 

Open the image of your file as a PDF by using the Create PDF tool in Acrobat. Choose Create 

PDF in the Tools menu, select your file and click Create. 

http://www.onelegal.com/blog/whats-the-best-pdf-software-for-your-law-firm-buyers-guide/


 

 

STEP THREE 

Your file will open as an image-based PDF. To apply OCR, choose Enhance Scans in the 

Tools menu. This will open the Enhance Scans menu at the top of the screen. 



 

 

STEP FOUR 

To apply OCR, select Recognize Text followed by In This File. A secondary menu will open. 

Make sure that you have the correct language selected and then click Recognize Text to begin 

the OCR process. 



 

 

STEP FIVE 

Finally, search for text in your PDF to check that the process has worked successfully. Use the 

keyboard shortcut Ctrl+F to open the Find menu. Type a word or phrase you know to be in the 

document. The word or phrase should become highlighted. 



 

 

The accuracy of the text recognition will vary depending on the quality of the image you upload. 

Higher resolution scans and images will be recognized more accurately. The accuracy of hand-

written documents can vary widely. You should audit your document carefully before 

considering it final. 

Method 3: Upload to One Legal 

At One Legal we understand that many law firms will not have the time or the requisite software 

to apply OCR to make documents text searchable. That’s why we’ve built a back-up into our 

platform. 

 

When you file via One Legal in an eFiling court we’ll perform a quick, automatic check to see if 

your document is text searchable. If it is, we’ll submit it directly to court. If it is not, then we will 

apply OCR to make it text searchable (and therefore compliant with the court’s rules) before 

submission (don’t worry — it’s automatic and only takes a few seconds).  

 

However, because the OCR process can never be 100% accurate it is recommended that you 

apply text recognition yourself and audit the results before submission.  

 

How to correct OCR errors using Adobe Acrobat 

Optical character recognition, usually abbreviated to just OCR, is the process of converting 

image files containing letters and words (such as scans or photographs) into searchable, text-

based documents. 



 

The biggest problem with the OCR process? It is very rarely perfect. While good quality originals 

(like screenshots or high-resolution scans of typed letters) may be recognized at 100% 

accuracy, poorer quality images will be less accurately recognized. 

So, low-resolution scans or fuzzy faxes may not reproduce well. Similarly, handwriting will 

almost never be accurately recognized as text. 

Therefore, when you scan images to include as exhibits in your court filing, it is very important to 

conduct an audit of the OCR results and correct any glaring and significant errors before 

considering the document finalized and ready to file with the court. 

How to audit OCR quality 

Acrobat offers a feature called “preflight,” part of which allows you to make the OCR text (that is 

the hidden text placed beneath the image that reflects the characters that the software 

recognized when OCR was applied) visible. 

Here’s how you make that hidden text layer visible so that you can review its accuracy: 

STEP ONE 

Open your OCR’d document in Adobe Acrobat. Now, in the right-hand tools panel, enter 

“preflight” into the search field. Select Preflight beneath Optimize PDF. 

 

STEP TWO 



 

The Preflight dialog box will open. In the search field, enter “Make OCR.” From the options that 

appear, select Make OCR text visible and then click Analyze and fix. 

 

Acrobat will ask you at this stage to re-name your file. It’s recommended that you add a note, 

e.g. “_review” to the file name so that you can easily identify this version later on. 

STEP THREE 

Now, to review the quality of the OCR that has been applied, you need to view the OCR layer. 

To view this layer, open the Layers panel by clicking on the layers icon in the left-hand menu. 



 

STEP FOUR 

The Layers panel will open. You will see two available layers that can be viewed. By default, 

both the scanned image and the invisible text are displayed. To review the quality of the OCR, 

you need to disable the image so that you can only see the OCR layer. Uncheck the eyeball 

beside the Visible page content icon to turn it off. 

Now, only the OCR text is visible on the screen. As you can see from the example, the quality of 

the OCR — especially for handwritten sections — is often, to put it mildly, rather low. 

 

How to correct OCR errors 

If the text that has not been correctly OCR’d is particularly pertinent, then you may wish to 

improve the document’s search quality by correcting the invisible text manually. Doing so is a 

two-step process in Acrobat: 

STEP ONE 

Open your OCR’d document in Acrobat. In the right-hand Tools panel search for “Correct” and 

select the Correct Recognized Text option beneath Enhance Scans. 



 

 

STEP TWO 

The Correct Text function will appear at the top of your screen. Check Review recognized 

text.Suspected errors will be highlighted in red. Simply select an error, type the correct text, and 

then click Accept. 

 

As you can see, this is quite a time-consuming and laborious process. You may, therefore, 

choose to make a judgment based on both the importance of the document being filed and your 

best sense of the quality of the original to which you applied OCR when deciding how much 

effort you wish to give to auditing your PDF. 

 



 

Correctly redacted 
Redaction — the permanent deletion of data from documents — used to be really simple. In the 

past, thick permanent marker pens were used to black out the information. 

These days, especially now that eFiling means that many documents need never be printed out, 

that process doesn’t make sense. It is slow, inefficient, and unnecessarily expensive (and 

printing out and scanning will leave you with a poor quality PDF). 

Digital redaction may seem as simple as blacking out sections with a pen — just replace that 

black marker pen by drawing on black boxes in Word, right? Not quite. Leaving aside that this 

will do nothing to delete the metadata, it’s actually pretty easy to remove these boxes (revealing 

the text beneath) via a simple copy and paste. 

Electronic filing makes redaction even more important 

In every court system that is implementing eFiling one of the (several) stated goals is to 

“promote electronic access to case files,” often by making them electronically available online. 

This increased availability of court documents means that correctly redacting sensitive, 

confidential, or personally-identifying information is crucial. 

Information, such as social security numbers, names of minor children, financial account 

numbers and so on, must be properly redacted and entirely irretrievable to someone viewing the 

submitted PDF. 

It’s your responsibility as the filer to get this right. Most eFiling rules state that redaction is the 

filer’s responsibility and that the clerks will not review pleadings for compliance. That means if it 

is revealed later that information was viewable because it wasn’t correctly redacted, it is on you. 

How to redact in Adobe Acrobat 

Note: Other PDF software is available. Check out our review of some of the best. 

The most recent version of Adobe Acrobat offers the quickest and simplest method to redact a 

document. It really only takes a few minutes. 

STEP ONE 

First, open the document you wish to redact. Go to the Tools menu, then select Redact. 

http://www.onelegal.com/blog/how-to-produce-court-friendly-pdfs/
http://www.onelegal.com/blog/how-to-remove-metadata-from-your-court-filings/
http://www.abajournal.com/news/article/cut-and-paste_reveals_redacted_info_on_apple_smartphone_market_in_federal_j/
http://www.onelegal.com/blog/whats-the-best-pdf-software-for-your-law-firm-buyers-guide/


 

 

STEP TWO 

Selecting this option will reveal the redaction menu at the top of your document. Select Mark for 

Redaction and then select Text & Images. 

STEP THREE 

Now you simply need to select the text that you want to redact. Once selected, Acrobat will 

highlight your selection in red. 



 

 

STEP FOUR 

Click Apply to redact. This is a permanent redaction, and so Acrobat pops up a warning box 

letting you know that. You’ll need to click OK to proceed. 



 

 

STEP FIVE 

Once you click OK Acrobat will ask if you wish to “also find and remove hidden information in 

your document” (otherwise known as metadata) You should consider this a vital stage in fully 

redacting information. It’s always better to be certain you’ve removed all possible traces of 

sensitive information by clearing the data too. Click Yes, let Acrobat search your document, and 

then click Remove. 

http://www.onelegal.com/blog/how-to-remove-metadata-from-your-court-filings/


 

 

Using the “Find Text” tool to double check 

If you’re filing a long document with many possible references to confidential or sensitive 

information then, for peace of mind, it is worth performing a quick search using Acrobat’s Find 

Text feature. 

Simply select Mark for Redaction followed by Find Text. This will open the Search dialog box 

on the left. Here, you can search for specific words (e.g. if there’s a name you need to redact), 

or for common patterns of sensitive information, such as credit card or social security numbers. 



 

 

The takeaway? If you regularly have to file electronically, or you’re in a practice area that means 

often handling sensitive and confidential information, it is recommended that you invest in 

professional PDF editing software and invest some time in learning it’s correct use. 

 

 

 
 

 

 

 

 



 

Scanned pages are high quality 

Exhibit scanning best practices 

 

It’s a near certainty that, no matter how hard you strive for your office to be paperless, you will 

find that you need to scan items such as incoming correspondence, signatures pages, and 

exhibits.  

 

Today, with more and more courts expecting documents to be electronically filed, being able to 

scan and distribute documents by PDF isn’t just a “nice to have:” It’s an essential office skill.  

 

To get started you’ll need a scanner in your office and, serious proponents of going paperless 

suggest, one on each desk. A fast and reliable scanner that is capable of handling a high 

volume of papers is a must. Check out our guide to choosing the best >> 

Scanning court exhibits 

One of the most important scanning tasks you’ll likely undertake is the preparation of the 

exhibits for your trial court papers.  

 

The advantages of having exhibits in electronic form wherever possible are substantial, 

especially in terms of the ease of sharing and simpler navigation (because of text searchability). 

However, there are some court requirements that you need to be aware of. 

 

The most important of these requirements is that scanned items be clearly legible to the human 

eye, free of defects that impede readability (like speckling, skewing, poor contrast, folded pages, 

tears, etc.), and scanned at sufficient quality (almost always a minimum of 300 dots/pixels per 

inch).  

Best practices for scanned exhibits 

To be confident that your scanned exhibits meet the court’s requirements for image quality, 

retention, and security you should follow these best practices: 

 

● Retain originals — Always keep the original and store it securely. It’s also best to store 

a copy of the scan of your exhibit in a secure drive and, ideally, backed up on your 

external hard drive.  

● Scan at 300 dpi — To ensure image quality, you should scan all exhibits at 300 dots per 

inch (also often referred to as pixels per inch). This is the minimum required by many 

rules of court (e.g. in California) and meets the National Archives Standards.  

http://www.onelegal.com/blog/tag/paperless-office/
https://lawyerist.com/71227/best-scanners-lawyers/
http://www.onelegal.com/blog/how-to-choose-the-right-scanner-for-your-law-office/


 

● Remove metadata — Before applying OCR, you should remove metadata from your 

files. There isn’t likely to be much on scanned items, but be aware that any comments or 

annotations that were electronically added in your office may still be visible unless 

completely wiped.  

● Apply optical character recognition — Most state court rules, including in California 

and Texas, require that exhibits be text searchable so far as is feasible. To achieve this, 

you’ll need to apply OCR. Make sure, though, that the OCR layer is hidden and does not 

replace the original image, which must remain visible. 

How to audit the quality of scanned images using Acrobat 

If you’re scanning an original item yourself, then you can be fairly sure of the image quality 

because you can choose the precise quality setting on your scanner.  

 

How, though, can you check if the image quality of exhibits that you have received electronically 

is sufficient?  

 

If the exhibit you’ve received electronically is largely written, e.g. a medical bill, record, letter, 

and so on, then you can use your judgment as to whether the contents are completely legible to 

the human eye. While exhibits like these are allowed to have imperfections, like folds, creases 

or tears, they must not block any text on the page. 

 

If the exhibit is a photograph or other image, you can use Acrobat’s Output Preview tool to 

view the details of the image and to check if it meets the court’s requirement that it contain at 

least 300 dots/pixels per inch. Here’s what to do: 

STEP ONE 

In the Tools menu on the right-hand side of the screen, search for “Output Preview.” Click on 

the option that appears to open the Output Preview dialog box. 

 



 

STEP TWO 

In the Output Preview dialog box, select Object Inspector in the Preview drop-down menu.  

 

STEP THREE 

Finally, scroll to the image that you wish to inspect, hover over it with the crosshair cursor, and 

click. When you click, Acrobat will display a list of information it can gather about the image, 

including its resolution.  

 



 

 
 

If your image is below the resolution required by the court, you have a few of options. First, try 

to obtain a better quality image; second, try to enhance the quality of the image; or finally, 

submitting the image but noting that it is the “best available.” 

 

 

 

 

  



 

Metadata has been removed 

 

Why you need to be removing metadata from your court 

filings 

Consider this scenario: you’re preparing to file a financial disclosure in a divorce case. To 

protect your client’s confidentiality, you’ve dutifully removed all of their bank details, their social 

security number, and so on from the Word document. 

You deleted it, so it’s gone permanently, right? Not so fast! 

It doesn’t take much digging on the part of someone with unsavory objectives to recover that 

data from your file. That’s because your changes, while invisible on the face of the document, 

have in fact been stored in its metadata, or background information. 

As eFiling becomes widespread and the courts move to online case management systems, the 

issue is becoming more pertinent. That’s because your document might end up online, 

accessible to anyone in the world. 

Fortunately, with a basic understanding of what metadata is and the process for properly 

eliminating it, you can make sure your deletions are truly removed. 

What is metadata? 

The phrase “metadata” is self-referential. That is, it is data about data. It’s basically all of the 

background information stored in your word processing document that enables you to undo 

edits, identify who made changes and when, and maintain formatting when it’s shared. 

Most metadata is pretty harmless — the author, time of creation, and so on. But, because it 

could potentially have recorded every change you made, including deletions, tracked changes, 

and comments, you need to be aware that it may contain information you wouldn’t want others 

to be able to see. 

Ethical obligations 

In light of the potentially serious consequences of a document’s metadata falling into the wrong 

hands the ABA and, so far, 18 state bar associations, have drafted formal ethics opinions 

governing metadata. 

http://www.americanbar.org/groups/departments_offices/legal_technology_resources/resources/charts_fyis/metadatachart.html


 

Most states consider correctly handling metadata to be a normal part of taking “steps 

reasonable in the circumstances to protect confidential client information against impermissible 

use,” in the words of the California State Bar (Formal Opinion No. 2010-179). 

Some states, for instance, Alabama and Arizona, place a prohibition on lawyers “mining” 

documents for metadata — that is, deliberately searching through a document’s metadata for 

anything that might advance their case. Most, however, place the obligation squarely on the 

party sending the documents. 

Fortunately, removing metadata from your documents is a quick and simple process. 

Never send anyone a Word document 

The Lawyerist blog promotes a useful mantra to remember: Word files are not documents. 

They’re drafts. In an online, electronic environment “a document must be a substitute for the 

actual paper.” 

Therefore “a PDF file can be a document. A Word file cannot. Write this down. Word files are 

drafts. They are never ever final documents.” 

Since most metadata is removed during the PDF conversion process, this is a pretty sure way 

to remove it and avoid any inadvertent error. However, to be certain you can also scrub the 

metadata in Word itself. 

Cleansing metadata from Word documents 

Here’s how to remove metadata in the latest version of Word. 

STEP ONE 

First, make a final copy of the document from which you’d like to scrub the data. It’s best to 

keep a final draft in your files in case you need any of the data later. 

STEP TWO 

In the final copy of your original document, click the File tab, and then click Info. You’ll see the 

Inspect Document tool front and center. 

http://ethics.calbar.ca.gov/LinkClick.aspx?fileticket=wmqECiHp7h4%3d&tabid=837
https://lawyerist.com/63820/paperless-tip-never-ever-send-word-files-as-correspondence/


 

 

STEP THREE 

To view the hidden data stored in your document, click the Check for Issues button, and then 

select Inspect Document. 

 



 

STEP FOUR 

Click Inspect and the Word will examine your file for metadata. Once the review is complete, 

click the Remove All beside the data you wish to remove to delete it permanently. 

 

Remember, once you delete this data it is gone, forever. If you think you might need to access it 

at some point, then don’t forget to pay attention to step one and only perform this action on a 

copy of your document. 

 

 

 

  



 

Signature rules complied with 

 

State courts across the United States (for example in California, Texas, and elsewhere) are 

rapidly implementing electronic filing systems to replace the older practice of filing at the court 

window. 

While the advantages of eFiling in terms of time and resources saved are substantial, it isn’t 

without its issues. One of the trickiest issues when it comes to electronic court filing? 

Signatures. 

In legal practice, signatures serve two essential functions: (1) Creating a verifiable link between 

the document and the filing party; and (2) Providing verification that the contents have been 

reviewed and meet certain standards. 

It’s important to know what the signature rules and expectations are for the documents you’re 

filing and the location into which you’re filing. We explain the basics below, but remember: It’s 

always best to consult your local clerk or local rules if you’re unsure. 

eFiling creates a verifiable link between the filer and the filed 

documents 

Unlike fax filing or other methods of having a court messenger file documents on your behalf, 

when you eFile there’s a verifiable link between you, the filer, and the documents you upload 

and submit to the court. 

That’s because eFiling systems require that you eFile using a login and password unique to 

you. This information follows through to the court’s computerized case management system, 

creating a direct link between you and the documents received by the court. 

This is why, when you eFile using One Legal in Texas or a California court using the eFileCA 

system, you need to connect your One Legal and your eFileTexas or eFileCA accounts. 

Therefore, most eFiling signature issues relate to documents signed by parties other than the 

registered user and where a signature is necessary to verify the contents of a filing. In these 

areas, court practice is diverse. 

eFiling and signatures: Rules in the state courts 

Most eFiling jurisdictions have therefore introduced rules that specify different signature 

requirements on documents filed under the filer’s name, and those that are notarized, sworn to, 

certified, made under oath, or containing the signatures of other parties. 

http://www.onelegal.com/efileca/
http://www.onelegal.com/texas/


 

However, even where rules have been made at the state level, local court clerks may have their 

own requirements. This is especially true in California where eFiling is being implemented on a 

court-by-court basis. This article is informational and general only. If you’re unsure of local 

expectations, it is always best to consult your local court rules or clerk directly. 

CALIFORNIA 

Rule 2.257 of the California Rules of Court covers the requirements for signatures on 

electronically filed documents. 

It states that, if a document is not signed under penalty of perjury then it is considered signed 

when eFiled. In reality, rather than leaving the signature line blank (though allowed), you might 

prefer to write in: /S/ (name of the person who signed the document). 

Where documents are signed under penalty of perjury, or where the signatures of other parties 

are required, the rule states that original, “wet” signatures must be obtained. These signature 

pages need not be eFiled but must be retained and presented to the court or another party if 

requested. 

Some courts, such as San Francisco Superior Court, ask that you submit a scanned image of 

the signature page when you eFile. The state rule, however, doesn’t specify and some local 

courts are content with the /S/ formulation, scanned signature images, or nothing at all (so long 

as the originals are available on request). 

TEXAS 

Rule 21(7) (The link is to the rules as updated in July 2016) states that either the /S/ formulation 

or a “scanned image of the signature” are sufficient “unless the document is notarized or sworn.” 

Where the latter applies, original “wet” signatures must be obtained, scans of these originals 

should be eFiled and the signed copies retained for inspection by the court or other parties 

should they make a request. 

ELSEWHERE 

Similar rules are being adopted in Indiana (see page 22), Illinois (page 4), and most other 

jurisdictions where eFiling is being adopted.  

 

  

http://www.courts.ca.gov/cms/rules/index.cfm?title=two&linkid=rule2_257
http://www.sfsuperiorcourt.org/online-services/efiling/efiling-faqs
http://www.txcourts.gov/media/1435952/trcp-all-updated-with-amendments-effective-912016.pdf
http://www.in.gov/judiciary/files/efiling-user-guide.pdf
http://www.illinoiscourts.gov/ebusiness/Sup_Ct_Efiling/SCt_efiling_user_manual.pdf


 

The file size is below the max 

The maximum file size that you can upload depends on where you are filing. Different courts 

operate different case management systems which can only accept certain sizes of file. When 

you use One Legal to file, our system will warn you if the the file you have uploaded exceeds 

the limit for that court.  

It’s best practice, though, to check your file size before you begin filing. For reference, here are 

the maximum files sizes for all of the locations you can currently file in using One Legal: 

State Court Individual file 
limit 

Total filing 
limit (all files) 

California 

Orange County 35 MB 60 MB 

San Diego 120 MB 120 MB 

San Francisco 120 MB 120 MB 

Stanislaus 25 MB None 

eFileCA (Fresno, Kern, 

Merced, Monterey, San Luis 
Obispo, San Mateo, Santa 
Barbara, Santa Clara, Santa 
Cruz) 

25 MB 25 MB 

Physical filing via One 
Legal (all counties not listed 

above) 

25 MB None 

Texas eFileTexas  35 MB 35 MB 

Hawaii, Idaho, Illinois, 
Kansas, Maryland, New 
York, Oklahoma, 
Pennsylvania, Utah, 
Washington 

Physical filing via One 
Legal  

25 MB None 

 

But what can you do if your file is too large? 



 

5 ways to reduce the size of a PDF 

We are often asked at One Legal how to reduce the size of a PDF filing to ensure that is 

accepted by a court’s case management system and therefore successfully eFiled. 

 

There’s a whole range of rules out there on file sizes depending on what back-office system the 

court is using to manage the filings it receives. In courts using the eFileCA system, for instance, 

all filings must be under 35 MB, whereas San Diego and Orange County accept sizes up to 120 

MB. Checking the local rules in your court in advance is important. 

 

In general, though, there’s very little reason for PDFs to be hundreds of megabytes large unless 

they contain exhibits that absolutely must be saved as very high-resolution photographs. By 

following just a few simple steps, even large filings that are hundreds of pages should not 

exceed 10 MB. 

How to determine the size of your PDF document 

If you’re using Adobe Acrobat, checking the size of your PDF is simple. Just click on File, then 

Properties. You’ll see lots of information about your document, including its size. 

 



 

Alternatively, you can navigate to the folder containing your document, right click on it, and click 

Properties. 

Larger files will take longer to upload, are cumbersome to share electronically (via email, for 

instance), and will use up your law firm’s file storage more rapidly. Also, while the courts accept 

larger file sizes, they prefer to handle smaller, optimized files. 

So, how should you set about reducing the size of your PDF documents? Here are five quick 

tips. 

#1 Avoid scanning PDFs wherever possible 

It’s a common misconception that, to create PDFs, or to combine multiple documents and 

exhibits into a single PDF, you need to to print everything out and scan it together. Electronically 

converted files are generally much smaller in size than scans. 

You only ever need to scan documents that exist in paper form only — all other documents can 

be electronically converted from the original file by saving them as PDFs. Furthermore, 

individual documents can be quickly combined as PDFs using software such as Adobe Acrobat, 

avoiding any need to print out documents to combine them. 

#2 Save as “Reduced Size PDF” 

If your file is still very large after you’ve created it electronically, rather than by scanning, there 

are still some steps you can take. The simplest is to re-save your file as a reduced-size PDF. 

In the latest version of Adobe Acrobat, open the PDF you wish to re-save as a smaller file, 

choose File,Save as Other, and then Reduced Size PDF. You’ll be prompted to select the 



 

version compatibility you need and then you can click OK to save. We recommend setting your 

compatibility with at least Acrobat X, as that version is still widely used. 

This method is quick and simple but be warned that it will reduce the quality of images and will 

remove digital signatures. If you want more control over how your PDF is compressed in 

Acrobat, use the optimization method described below instead. 

#3 Use Adobe Acrobat’s PDF Optimizer 

Sometimes you’ll want more control over which elements of your document are reduced in 

quality or removed. In these circumstances, you should choose the PDF optimizer tool. 

 

Before you optimize a file, it’s a good idea to audit the file’s space usage — review which 

elements, such as fonts, images, and so on, are using the most data. The results of this may 

give you ideas about where best to reduce file size. 

 

To begin optimization, open your PDF in Acrobat, click File, Save as Other, and then Optimized 

PDF. In the dialog box that appears, click on Audit space usage in the top right-hand corner. 

You’ll see a table of information a bit like this: 

 

The optimizer gives you complete control over the elements of your PDF that will be 

compressed. Select the checkbox next to a panel (e.g. Images, Fonts), and then select options 

in that panel. There’s a lot of choices, so it’s worth reading through the Adobe help file to 

understand what each option does. 

https://helpx.adobe.com/acrobat/using/optimizing-pdfs-acrobat-pro.html


 

Okay, we know that not everyone uses Adobe Acrobat. What options are available to you if 

you’re using other software or only the basic Adobe Reader? Here are two more options for 

reducing the size of your PDF file if you’re not using Acrobat. 

#4 Reduce the size as you save in Word 

In Word, to convert a document to PDF, you use the Save As option. This option generally 

produces a fairly small file, depending on the number of images in your document. However, if 

you find that your Word-converted PDF is still too large, there is a further option in Word that will 

produce a significantly smaller file. Here’s how to use it: 

Open the Word document you are going to convert to PDF. Click on the File button and then 

Save As.In the Save as type menu, select PDF and enter your preferred file name. Here’s the 

extra step: where it says Optimize for at the bottom of the dialog box, select Minimum size 

(publishing online). 

 

#5 Use a print-to-PDF tool 

Other (non-Adobe) PDF tools generally contain features that will reduce the size of your PDF. 

However, if you’re looking for a free option, there are some available. Currently, the most 

downloaded free PDF creator (according to download.com) is PrimoPDF. 

http://download.cnet.com/s/design-pdf/windows/


 

Once you’ve installed PrimoPDF, simply open the PDF you wish to compress (in Acrobat 

Reader, or a web browser, for example), press ctrl+P to open the print dialog, select PrimoPDF 

from the list of available printers, and then click Create PDF. 

Note that this method, like simply saving as a reduced-size PDF in Adobe Acrobat, reduces 

image quality and resolution. 
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